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Linuxowe DDoS’owanie

Kali Linux — DDOS

Opracowanie: Michat Suchon



Przypomnienile

. Jakie sg metody tamania hashy?

2. Czym rbézni sie hashowanie od szyfrowania?

3. Czym rbézni sie DoS od DDoS'a?
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1. Jakie sg metody tamania hashy?

Atak brute force (sitowy) — tamanie hasha, polegajgce na poréwnaniu réznych kombinacji znakéw i
znalezieniu wtasciwego; czasochitonny

Atak dictionary (stownikowy) - tamanie hasha, w ktérym korzystamy z bazy mozliwych haset (zazwyczaj
pochodzgcych z wyciekéw baz danych); zajmuje mniej czasu i zwigksza szanse na znalezienie hasha
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pochodzgcych z wyciekéw baz danych); zajmuje mniej czasu i zwigksza szanse na znalezienie hasha

2. Czym rbézni sie hashowanie od szyfrowania?
szyfrowanie jest procesem odwracalnym (szyfrowanie i deszyfrowanie) - hashowanie nie. Odczytanie
informacji z hasha, np. zbadanie poprawnosci hasta, polega na poréwnaniu dwéch cigqgéw zahashowanych
tym samym algorytmem (RSA, SHAI etc.)
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Przypomnienile

1. Jakie sg metody tamania hashy?

Atak brute force (sitowy) — tamanie hasha, polegajgce na poréwnaniu réznych kombinacji znakéw i
znalezieniu wtasciwego; czasochitonny

Atak dictionary (stownikowy) - tamanie hasha, w ktérym korzystamy z bazy mozliwych haset (zazwyczaj
pochodzgcych z wyciekéw baz danych); zajmuje mniej czasu i zwigksza szanse na znalezienie hasha

2. Czym rbézni sie hashowanie od szyfrowania?

szyfrowanie jest procesem odwracalnym (szyfrowanie i deszyfrowanie) - hashowanie nie. Odczytanie
informacji z hasha, np. zbadanie poprawnosci hasta, polega na poréwnaniu dwéch cigqgéw zahashowanych
tym samym algorytmem (RSA, SHAI etc.)

3. Czym rbézni sie DoS od DDoS'a?
DoS - atak z uzyciem jednego komputera (denial of service)

DDoS - atak przeprowadzany przez wiele urzgdzen jednocze$nie (komputery zombie), bez wiedzy ich
wtascicieli (distributed denial of service)



Co to byt atakR DoS?



Blokada usiug [DoS]

‘DOS‘



wyczerpanie wolnych portow

flooding pakietéw do sieci, na serwerze WWW [ FTP

przecigzajqc pasmo hosta

wykorzystanie btedu, ktory zapetnienie systemu pIiI.<<’>w,
zablokuje dziatanie aplikacii aby dalsze dodawanie
informaciji byto niemozliwe




Sprawdzenie skutecznosci DDoS’a (1)

IsltDown

y
L
& Is It Down Right Now ? + Website Status Checker Bookmarklet

"Is It Down Right Now" menitors th ) i nd checks whether they Once added to your toolbar, this button will Iet you to check the
or not. Check a website 5 y by using tne DeID test tool. Just enter the url and i e from your browser's foolbar.
ite status test will be performed on the domain name in real time ine . ar- HE Down Right Now?
checker tool. For detailed information, check response time graph and use -

Enter a domain below to check whether it is down or not...

=
@ monster.co.uk - Monster UK
@ hightail.com - Hightail
EE Top Websites Serveris up. Last checked 7 secs

Netflix Facebook
@ Faceb
ago. 5

@ riteaid.com - Rite Aid Pharmacy

Youtube Yahoo Mail Server is up. Last che:

@ Youtube_com is up. Checked 2 mins ago. @ Mail.yahoo.com is up. Ch

=9 % Down Right Now

Google Outlook @ bimmerpost.com - Bimmerpost
gle com is up. ecked 9 mins ago. @' Outlogk.com is up. Checked 19 mins ago. Server is down. Last 7 mins ago.
@ unionbankph.com - Union Bank PH
Steam Community Yahoo Server is d Las cked & mins ago.
@ Steamcommunity.com ] 1 hour 39 om is up. Gl 4 fanfiction.net - FanFiction
ming ago. Serv d Lasl ked 29 mins ago.
d barnesandnoble.com - Barnes & Noble
WhatsApp Windows Live Hotmail Server is down. Last ked 3 mins ago.
‘hatsapp.com is down. Checked 3 3 C - Checked 55 mins ago. 4 marriott.com - Marriott
6 hours 13 mins age.
Instagram Gmail
r.am is up. Checked 1 min ago. @' Mazil.google.com is up. Checked & mins
ago

Dropbox Battle Net US

om is up. Checked 2 hours 38 mins ago. @ Battle netis up.

FanFiction

http.//www.isitdownrightnow.com/
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Sprawdzenie skutecznosci DDoS’a (2)

1 -
detector” @PL~ Diabiznesu Onas Q

by Dokl

Monitorowanie probleméw i przestojow w czasie rzeczywistym

Informujemy Cieg, kiedy Twoje ulubione ustugi majg
problemy.

plusd vectra T Mobile

Plus Vecira

A

| . A\ i
A P M AM st

https.//downdetector.pl/
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JakR przeprowadzic¢ ataR
DDoS przez Kal1i?



Ettercap

Wielozadaniowy program, ktéry pozwala na np. przekierowywanie potgczen bgdz
diagnostyke ruchu w sieciach lokalnych (LAN). Program ten, ze wzgledu na sposob
dziatania zalicza si¢ do grupy tzw. snifferéow (z ang. sniff — weszyc). W Ettercap
mozliwe jest rowniez przeprowadzenie atakéw DDoS.
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10.

1.

12.

CWICZENIE 1 | ETTERCAP

Wyszukujemy program ettercap-pkexec.

Podajemy hasto do roota (kali)

Klikamy przycisk z ,checkiem”, po czym zatrzymujemy dziatanie programu przez biaty kwadrat w
lewym gérnym rogu.

DDoS-owanie w Ettercap to dodatek do programu, dlatego klikamy trzy kropki w prawym gornym
rogu, a nastepnie: Plugins > Load a plugin...

Szukamy pliku o nazwie ec_dos_attack.so, zaznaczamy i klikamy OK.

Nastepnie, ponownie klikamy w trzy kropki i Plugins, ale wybieramy Manage plugins.

Aby wiqczyC plugin, wystarczy na niego klikng¢é dwa razy -> klikamy zatem dwa razy w dodatek
dos_attack.

Po kliknigciu pojawi nam sie okienko ,Insert victim IP” — podajemy IP celu ataku. W tym celu uzyjemy
strony testsite.cytr.us, ktérego IP mozna pozna¢ przez uzycie polecenia ping w terminialu dla tej
domeny.

Po odpaleniu poleceniaq, kopiujemy IP i zatrzymujemy pingowanie przez kombinacje klawiszy CTRL + Z
(lub po prostu zamykamy terminal).

Wklejamy IP do okienka i klikamy OK.

Pojawi sie kolejne okienko ,Insert unused IP” — tutaj rowniez wklejamy to samo IP i potwierdzamy przez

~OK".

Na koncu klikamy biaty tréjkgt w lewym gérnym rogu, aby uruchomic¢ atak. Sprawdzamy rezultaty
(Mozna podejrze¢ porty: trzy kropki > View > Connections lub statystyki > View > Statistics).



Krok 1:

) 1 Authenticate

G, Authentication is required to run Ettercap
v

An application is attempting to perform an action that requires
privileges. Authentication is required to perform this action.

Password ssas

b Details
® Cancel Authenticate

@ kali

Q|

LIRS @ ettercap-pkexec
@ Recently Used [ N
mitmproxy
I All Applications -
=t ss|ldump
! Usual Applications .
sy Ssisplit

Q 01- Reconnaissance

% 02 - Resource Development
@ 03 - Initial Access

E™ 04 - Execution

E 05 - Persistence

G 06 - Privilege Escalation
@ 07 - Defense Evasion

g 08 - Credential Access

09 - Discovery

Q) 10 - Lateral Movement

11 - Collection

12 - Command and Control
F¥) 13 - Exfiltration

@ 14 - Impact

@ 15 - Forensics

Eﬁ' 16 - Services and Other Tools
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Ettercap

0.8.31

Krok 2:

- | —

Setup
Sniffing at startup ‘

Primary Interface  ethO
Bridged sniffing

Bridged Interface  Local Loopba

: (X
-
| I ¥
=n Ettercap
; Q= 0.8.3.1(EB)

28230 mac vendor fingerprint

1766 tcp OS fingerprint

2182 known services

Lua: no scripts were specified, not starting up!
Starting Unified sniffing...

_—

|



Krok 3:

Cancel

® Recent
#& Home
m Desktop

Other Locations

1

Select a plugin...

B usr b

WETE

ec_arp_cop.so

ec_autoadd.so

ec_chk_poison.so
ec_dns_spoof.so
ec_dos_attack.so

ec_dummy.so

ec_find_conn.so

ettercap

* Size

14.4 kB
14.4kB
14.4kB
22.6 kB
14.4 kB
14.2 kB
14.4 kB

ec_find_ettercap.so 14.4kB

mem Flemd P

44 A 1D

b

Type

Shared library
Shared library
Shared library
Shared library
Shared library
Shared library
Shared library
Shared library

Chaead lhea e

Modified

30 Nov 2024
30 Nov 2024
30 Nov 2024
30 Nov 2024
30 Nov 2024
30 Nov 2024
30 Nov 2024
30 Nov 2024

ETAN NI Tats I ]

= & | ——

Ettercap o o :

1 Plugins
Manage plugins
Load a plugin...

B oeal_
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Kr‘Ok 4: el = e ® ® :

4 Plugins
Manage plugins
Load a plugin...

]

n ! &
B ee A E Ettercap
Plugins x

Name Version Info
p— arp_cop 11 Report suspicious ARP activity

autoadd 12 Automatically add new victims in the target range

chk_poison 11 Check if the poisoning had success
" dns_spoof 13 Sends spoofed dns replies
i dos_attack 1.0 Runa d.o.s. attack against an IP address *DOUB L E C L IC K*
: dummy 3.0 A plugin template (for developers) W . L

| find_conn 1.0 Search connections on a switched LAN
- find_ettercap 2.0 Try to find ettercap activity "
= find_ip 1.0 Search an unused IP address in the subnet
S

1766 tcp OS fingerprint

2182 known services

Lua: no scripts were specified, not starting up!
Starting Unified sniffing...

Unified sniffing was stopped.



Krok 5:

g @ » q H Ettercap
Plugins x
arp_cop 11 Report suspicious ARP activity
autoadd 12 Automatically add new victims in the target range
chk_poison 11 Check if the poisoning had success
i = 4 Cancel ettercap Input QK

dummy =0 0 InsertunusedIP: | 135.181.95.85

find_conn 1.0 S
find_ettercap 2.0 T esnissemsranibastvg
find_ip 1.0 Search an unused IP address in the subnet

2182 known services
Lua: no scripts were specified, not starting up!
Starting Unified sniffing...

Unified sniffing was stopped.
Activating dos_attack plugin...

— - — o R

>

]

Plugins x

arp_cop
autoadd
chk_poison
dns_spoof

]
@®

Q

"

11
12
1.1
13

3.0
1.0
2.0
1.0

—~i —

Ettercap

Report suspicious ARP activity
Automatically add new victims in the target range
Check if the poisoning had success

E Cancel ettercap Input oK

5 0 Insert victim IP: | 131.181.95.85
Si

T jssrrmsmmerespmssrrsy

Search anunused IP address in the subnet

l;:ecified, not starting up!
g

topped.
plugin...

R — . —

® ® :



Krok

mQ =
Plugins x
Name Version
arp_cop 1.1
autoadd 1.2
chk_poison 1.1
dns_spoof 13
*  dos_attack 1.0
dummy 3.0
find_conn 1.0
find_ettercap 2.0
find_ip 1.0

- Unified sniffing was stopped.
Activating dos_attack plugin...

6:

- e [

Ettercap

Info

Report suspicious ARP activity

Automatically add new victims in the target range
Check if the poisoning had success

Sends spoofed dns replies

Runad.o.s. attack against an IP address

A plugin template (for developers)

Search connections on a switched LAN

Try tofind ettercap activity

Search an unused IP address in the subnet

dos_attack: Starting scan against 135.181.95.85 [Fake Host: 135.181.95.85]

Starting Unified sniffing...

dos_attack: Starting attack...

® @ :

4 View
Connections
Profiles

Statistics

»>

Plugins x

Name
arp_cop
autoadd
chk_poison
dns_spoof
dos_attack
dummy

find_conn

Resolve IP addresses

Visualization method...

Visualization regex...

Set the WiFi key...

Q

"

Version
11

1.2

1.1

13

1.0

3.0

1.0

2.0

1.0

e

ffing...

; stopped.
ck plugin...

Ettercap

Info

Report suspicious ARP activity

Automatically add new victims in the target range
Check if the poisoning had success

Sends spoofed dns replies

Runa d.o.s. attack against an IP address

A plugin template (for developers)

Search connections on a switched LAN

Try to find ettercap activity

Search anunused IP address in the subnet

R e e o

jscanagainst131.181.95.85 [Fake Host: 135.181.95.85]

I;attack...



Co jesli strona posiada
certyfikRat SSL?



Connection ./

Secure Sockets Layer

Protokét, wykorzystywany do zabezpieczania komunikacji miedzy klientem a
serwerem w siecl. Dzigki niemu, niezaleznie jakiego rodzaju dane wysytamy lub
odbieramy, wszystkie informacje miedzy naszq przeglgdarkg a serwerem sg
szyfrowane. Strony wykorzystujgce ten protokét dia swojej .domenx, muszq posiadac
spec;la!ny certyfikat SSL, ktory jest pod te domene podpinany. PoSwiadcza on, ze
wszelkie dane (jak maile czy dane logowania) pozostajg chronione - strona
Eosmdajqca taki certyfikat bedzie posiadac symbol zielonej ktodki przy adresie oraz

edzie korzysta¢ z https zamiast http.

Brak zielonej ktodki = brak certyfikatu. Wowczas, nawet jesli komunikacja odbywa
si¢ przez HTTPS, to nadal jest narazona na dziatania cyberprzestepcow, np. przez
atak MITM (man-in-the-middile).

Obechie, niemal 99,99% stron obstuguje protokot SSL na porcie 443.



How SSL Certificates Work

SSL certificates create encrypted
connections through a shared secret key.

HTTPS://

The user enters an
HTTPS address.

Your browser sends

encrypted data and
a secret key.

The server shares
its SSL certificate
and a public key.

The server
decrypts the data
and receives the

secret key.

Your browser
verifies the
SSL certificate.

6
S

The web browser
and server share
encrypted data
using the shared
secret key.
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THC-SSL-DOS

Narzedzie, dzigki ktéremu sprawdzimy wydajnosé SSL'a — ustanowienie potgczenia bezpiecznym przez
SSL wymaga ok. 15 razy wigkszej mocy obliczeniowej na serwerze niz kliencie.

Narzedzie to wykorzystuje te wiasciwosc, w ten sposob przecigzajgc serwer i powodujgc zatrzymanie
ustug, umozliwiajgcych udostepnienie strony w sieci.

Problem ten byt na tyle dotkliwy, ze od 2003 roku prowadzono szeroko dyskusje na ten temat miedzy
dostawcami ustug.

W ramach pojedynczego potgczenia TCP, atak ten pozwala wywotywaé tysigce renegocjacji (ze
wzgledu na to, ze SSL w swojej komunikacji uzywa kilkukrotnej renegocjacji migedzy hostem a
serwerem, aby zepewnié bezpieczenstwo i bezstratnoéé potqgczenia)



THCattacker

Chent response time
for each request

Server response tims
for each reply

1time
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Sender Receiver Sender Receiver

-

# Request

Response

Response

Response
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CWICZENIE 2 | DDoS z SSL’enm

Odpalamy terminal i wpisujemy: the-ssl-dos —h (opis dziatania polecenia)

. Uruchamiamy atak, podajqgc:

thc-ssl-dos —-1100 192.168.1.1.208 443 —accept

. Obserwujemy rezultaty. Uwaga! Atak nie zawsze sie udaje. Z czego wyhnika ten
problem?



CWICZENIE 2 | DDoS z SSL’enm

Odpalamy terminal i wpisujemy: the-ssl-dos —h (opis dziatania polecenia)

. Uruchamiamy atak, podajqgc:

thc-ssl-dos —-1100 192.168.1.1.208 443 —accept

. Obserwujemy rezultaty. Uwaga! Atak nie zawsze sie udaje. Z czego wyhnika ten
problem?

DLACZEGO ATAK MOZE SIE NIE POWIESC?

Atak dziata na konkretnych, starszych, wersjach certyfikatéow SSL. Obecne certyfikaty
pozwalajq skutecznie zapobiec temu atakowi. Nie wszystkie bowiem narzedzia
popularne i skuteczne kiedy$ (jak thc-ssl-dos) sg nadal efektywne przez rosngcg
SwiadomoS¢ pewnych zagrozen i rozwijajgce sie sposoby zapobiegniecia im.

Wiecej o aktualnych podatnosciach i iloSciach stron narazonych na specyficzne ataki
mozemy odczytac tutaj: https:[/[www.cvedetails.com/cve/CVE-2009-3555/
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Slowloris

Narzedzie do DDoS’owania, ktore w odréznieniu od innych nie zalewa serwera pakietami
(tatwymi do odrzucenia i zablokowania poiqczeniay, a otwiera wiele réwnolegtych
potgczen HTTP -> KAZDY SERWER MA OGRANICZONA LICZBE POtLACZEN, JAKIE SA W STANIE
W JEDNEJ CHWILI OBStUZYC (Dlatego zapisy nha zajecia na studiach bywajg
czasochtonne...). Slowloris jest skryptem napisanym w jezyku Perl, jednak w Kalim istnieje
jego odpowiednik w Pythonie.



5.
6.

CWICZENIE 2 | SLOWLORIS

Sprawdzamy, czy posiadamy na maszynie pythona: python —version. Jesli nie maq,
instalujemy: sudo apt install python3
Przechodzimy przez polecenie ed do pulpitu (Desktop). Pobieramy repozytorium z
GitHub’a przez polecenie git clone https://github.com/gkbrk/slowloris.git (Jesli
polecenie nie dziata, doinstalowujemy git'a: sudo apt install git ).
Wyswietlamy wszystkie pliki (Is =la), poleceniem ed slowloris przechodzimy do
folderu ze skryptem.
Aby uruchomic Slowloris, wpisujemy:

- python3 slowloris.py {adres strony}

przyktad: python3 slowloris.py testsite.cytr.us

Sprawdzenie podatnosci: Ibd {adres strony}
Na koncu, aby przeprowadzi¢ atak, podajemy komende: .[slowloris.py

UWAGA! ABY SKRYPT ZADZIALAL, MUSI POSIADAC UPRAWNIENIA DO URUCHOMIENIA (x
lub 1, najlepiej ustawié 777) -> wpisujemy chmod 777 slowloris.py
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( )-[~]
L cd Desktop

[:—( )-[~/Desktop ]
git clone https://github.com/gkbrk/slowloris.git
Cloning into 'slowloris’
remote: Enumerating objects: 152, done.
remote: Counting objects: 100% (66/66), done.
remote: Compressing objects: 100% (29/29), done.
remote: Total 152 (delta 39), reused 37 (delta 37), pack-reused 86 (from 2)
Receiving objects: 100% (152/152), 27.79 KiB | 4.63 MiB/s, done.
Resolving deltas: 100% (78/78), done.

[:—( )-[~/Desktop]

cd slowloris

[:—( )-[~/Desktop/slowloris]
chmod 777 slowloris.py

[:—( )-[~/Desktop/slowloris]
python3 slowloris.py testsite.cytr.us

[16-07-2025 10:18:23] Attacking testsite.cytr.us with 150 sockets.
[16-07-2025 10:18:23] Creating sockets ...

[16-07-2025 10:18:38] Sending keep-alive headers ...

[16-07-2025 10:18:38] Socket count: 150

[16-07-2025 10:18:54] Sending keep-alive headers ...

[16-07-2025 10:18:54] Socket count: 150

[16-07-2025 10:19:09] Sending keep-alive headers ...



Uprawnienia w Linuxie

Wykorzystuje tzw. ugo, czyli podziat na uprawnienia kolejno dia:

uzytkownika/wtasciciela (u), grupy przypisanej do pliku lub katalogu
(g). pozostali uzytkownicy (o)

—I'w-rw- 1 kali kali 6 Jul 1 16:12 blabla.txt

\ \ UPRAWNIENIA DO PLIKU
u (user)

wtasciciel pliku g (group)
grupa
uzytkownikow,
przypisanych do
pliku

o (others)
Dostep dla pozostatych uzytkownikdw systemu
przy stronach internetowych: kazda osoba, ktora

Jesli sprawdzany zaséb do bedzie chciata wyswietli¢ strone)
katalog, pojawi sie tutaj

oznaczenied



Uprawnienia w Linuxie

Wykorzystuje tzw. ugo, czyli podziat na uprawnienia kolejno dia:

uzytkownika/wtasciciela (u), grupy przypisanej do pliku lub katalogu
(g). pozostali uzytkownicy (o)

drwxr-xkr-x| 4 kali kali 4096 Jul 9 12:16

UPRAWNIENIA DO KATALOGU

u (user)
wtasciciel pliku g (group)
grupa
uzytkownikow,
przypisanych do
pliku

o (others)
Dostep dla pozostatych uzytkownikdw systemu
przy stronach internetowych: kazda osoba, ktora

Jesli sprawdzany zaséb do bedzie chciata wyswietli¢ strone)
katalog, pojawi sie tutaj

oznaczenied



Uprawnienia w Linuxie

2 2 ODPOWIEDNIK
WARTOSC LITEROWA LICZBOWY RODZAJ UPRAWNIENIA
, 4 odczyt
read
zapis (modyfikacja)
W 2 .
write
wykonanie
X 1 (uruchomienie)
execute
JAKODCZYTUJEMY?

Wystarczy zsumowac odpowiedniki liczbowe i tak uzyskujemy
uprawnienia dla danej osoby, np.:

-rwxr-xr-- kali kali123 Feb 5 13:05 tajnyplik.txt
Dla usera-> 4+2+1=7,group -> 4+1 =5; others -> 4

UPRAWNIENIA PLIKU TO 754




Uprawnienia: przykiady

prawa dostepu wartosc¢ liczbowa opis
A e Tylko wiaSciciel ma prawo do odczytu i
rw 600 zapisu
R WtasSciciel ma prawo do zapisu i
rw=r==T 644 odczytuy, reszta tylko prawo odczytu
_ _ _ _ Wszyscy majg prawo do odczytu i
rW-rw-rw 666 zapisu
ANV e Tylko wiasciciel ma prawo do odczytuy,
rwX 700 zapisu i uruchomienia
Wiasciciel ma wszystkie prawa do
—IrWXIr=Xr-x 7955 pliky, reszta tylko do odczytu i
uruchomienia
_ Wszyscy majqg wszystkie prawa do
FWXIWXrwx 777 oliku
_ oy Wszystkie prawa ma wiasciciel, reszta
PWX—=X==X /1 tylko do uruchomienia
______ Wiasciciel katalogu ma petne prawa
drwx 700 do niego, reszta nic
R Wiasciciel ma petne prawa do
drwxr—r 744 katalogu, reszta tylko do odczytu




Podsumowanie

—

Jakimi narzedziami mozna przeprowadzi€ atak typu DDoS w Kali Linuxie?
Ktére polecenie umozliwia nam pobieranie bgdz aktualizowanie programow [
bibliotek / wtyczek w Kali Linux?

Za pomocg jakiego polecenia zmieniamy uprawnienia do pliku lub katalogu w
Linuxie?



Polecam!
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ZRODLO:
https://youtu.be/Ex2xz0ZOKKs



https://youtu.be/Ex2xz0ZOKKs
https://youtu.be/Ex2xz0ZOKKs

Polecam!

COMPARISON

TC ﬁvis ‘
—UDP

ANIMATED

ZROD!O:
https://www.youtube.com/watch?v=uwoD5YSGACg



https://www.youtube.com/watch?v=uwoD5YsGACg
https://www.youtube.com/watch?v=uwoD5YsGACg

	Linuxowe DDoS’owanie
	Przypomnienie
	Przypomnienie
	Przypomnienie
	Przypomnienie
	Co to był atak DoS?
	Blokada usług [DoS]�denial of service
	DoS�przykłady
	Sprawdzenie skuteczności DDoS’a (1)
	Sprawdzenie skuteczności DDoS’a (2)
	Jak przeprowadzić atak DDoS przez Kali?
	Ettercap
	ĆWICZENIE 1 | ETTERCAP
	Krok 1:
	Krok 2:
	Krok 3:
	Krok 4:
	Krok 5:
	Krok 6:
	Co jeśli strona posiada certyfikat SSL?
	SSL�Secure Sockets Layer
	Slajd numer 22
	THC-SSL-DOS
	Slajd numer 24
	Slajd numer 25
	ĆWICZENIE 2 | DDoS z SSL’em
	ĆWICZENIE 2 | DDoS z SSL’em
	Slowloris
	ĆWICZENIE 2 | SLOWLORIS
	Slajd numer 30
	Uprawnienia w Linuxie
	Uprawnienia w Linuxie
	Uprawnienia w Linuxie
	Uprawnienia: przykłady
	Podsumowanie
	Polecam!
	Polecam!

